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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground.

The TReK CFDP application provides the capability to transfer files using the
Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol
(CFDP).

1.1 Getting Started

Start with the Introduction which provides an application overview. Next, try the Quick
Start Guides for “How Tos” for common functions. For help with details, reference the
Details section. See the FAQ and Troubleshooting section for helpful hints and solutions
to the common “gotchas”.

1.2 System Requirements
Windows 7, Red Hat Enterprise Linux 6.x.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK software
applications, please try the following suggestions:

Read the corresponding material in the manual and/or on-line help.
Ensure that you are correctly following all instructions.

Checkout the TReK Web site at http://trek.msfc.nasa.gov/ for Frequently Asked
Questions.

If you are still unable to resolve your difficulty, please contact us for technical assistance:

TReK Help Desk E-Mail, Phone & Fax:

E-Mail: trek.help@nasa.gov
Telephone: 256-544-3521 (7:00 a.m. - 3:30 p.m. Central Time)
Fax: 256-544-9353

TReK Help Desk hours are 7:00 a.m. — 3:30 p.m. Central Time Monday through Friday.
If you call the TReK Help Desk and you get a recording please leave a message and
someone will return your call. E-mail is the preferred contact method for help. The e-
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mail message is automatically forwarded to the TReK developers and helps cut the
response time.

3 Introduction

The TReK CFDP application provides the capability to transfer files using the
Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol
(CFDP).

The CCSDS File Delivery Protocol (CFDP) was developed by the Consultative
Committee for Space Data Systems (CCSDS). Official specifications are contained in a
CCSDS document called the CFDP Blue Book (available at www.ccsds.org). The CFDP
protocol provides reliable transfer of files from one computer to another, and has been
designed to work well over space links. It can be used to perform space to ground,
ground to space, space to space, and ground to ground file transfers.

CFDP requires a sender and a receiver. The sender and receiver must be configured and
running at the same time to perform a file transfer. Each party is referred to as an
“Entity”. The sender is an entity and the receiver is an entity. Each “Entity” must have a
unique Entity ID. For example:

Computer 1 CFDP Computer 2
CFDP Application o = CFDP Application
Entity 1D (EID) 1 Entity 1D (EIDY) 2

Figure 1 CFDP Sender and Receiver

To move a file from one computer to another, you will enter one or more CFDP
Commands (primitives) to indicate the action to be taken. The syntax of a primitive is as
follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]

The TReK CFDP application provides support for CFDP over User Datagram Protocol
(UDP) and CFDP over Bundle Protocol (BP) using the Jet Propulsion Lab (JPL)
Interplanetary Overlay Network (ION) Delay Tolerant Networking software. The CFDP
over UDP configuration option is referred to as Native CFDP. The CFDP over BP
configuration option is referred to as ION CFDP. In the Native CFDP configuration, the
application uses UDP sockets and a Goddard Space Flight Center (GSFC) CFDP library
that performs the CFDP work. In the ION CDFP configuration, the TReK CFDP
application communicates with the ION software which performs the CFDP work.

There are differences in capabilities and syntax between the CFDP Native mode and the
ION CFDP mode. These differences are summarized below.


http://www.ccsds.org/
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Native CFDP Configuration
The syntax of a primitive is as follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]
Native CFDP Example: put class2 D:\filel.txt 2 /home/kirk/filel.txt

The TReK CFDP application currently supports two CFDP Directives in the Native
CFDP mode: put and get. These are defined as follows:

put:  to copy one file from the local entity to the remote entity.
get:  to copy one file from the remote entity to the local entity.

Valid Transmission values are classl or class2. Classl does not guarantee reliable
delivery of the file to the destination. Class2 does ensure reliable delivery.

The file you want to transfer is considered the “Source” and the location it should be
transferred to is considered the “Destination”.

Note: Native CFDP does not allow spaces in Source and Destination entries.

ION CFDP Configuration
The syntax of a primitive is as follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]
ION CFDP Example: put //// “D:\filel.txt” 2 “/home/kirk/filel.txt”
The TReK CFDP application currently supports multiple CFDP Directives in the ION

CFDP mode. This includes get and put, multiple filestore directives, and the message
directive. These are defined as follows:

Directive Description

append_file append a file at the remote entity to another file at the remote
entity.

create_dir create a directory at the remote entity.

create_file create an empty file at the remote entity.

delete file delete a file at the remote entity.

deny_dir delete a directory at the remote entity. (like remove_dir, but does
not fail if the directory does not exist)

deny _file delete a file at the remote entity. (like delete_file, but does not fail
if the file does not exist)

get copy one file from the remote entity to the local entity.

message send a text string to the remote entity.

put copy one file from the local entity to the remote entity.
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remove_dir delete a directory at the remote entity.

rename_file rename a file at the remote entity.

replace_file replace a file at the remote entity with another file at the remote
entity.

Some directives only require a Source. The following table describes what is required for
Source and Destination for each directive. Name of file, filename, and name of directory
refer to an absolute path.

Directive Source (first file) Destination (second file)

append_file | name of file whose contents name of file whose contents will form
form first part of new file and second part of new file
name of the new file

create_dir | name of directory to be created

create_file | filename to be created

delete_file | filename to be deleted

deny dir name of directory to be deleted

deny file filename to be deleted

get filename for file retrieved filename of file to retrieve

message message

put filename of file to send filename for file stored

remove_dir | Name of directory to be deleted

rename_file | old filename new filename

replace_file | filename whose contents are to | filename whose contents will replace the
be replaced contents of the first filename

ION CFDP supports spaces in Source and Destination entries. When entering a Source
or Destination in a CFDP command line, it must be encapsulated in double quotes.

The Transmission entry for ION CFDP is composed of five properties. Once these
properties are configured, a “////” string is used to indicate that the pre-configured values
should be used. The “////” nomenclature is shorthand notation for the following
combination of values:

Lifespan/Bundle Protocol Class of Service/Expedited Priority Ordinal/Transmission Mode/Criticality

When the values are empty it indicates that pre-configured values should be used for
these properties.

A summary of the Transmission properties is provided below. For details, please
reference section 6.1.2.

Property Description

Lifespan The lifespan is the bundle's "time to live" (TTL) in
seconds. The bundle is destroyed if its TTL has
expired and it has not reached its destination.
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Bundle Protocol Class of Service | The Bundle Protocol Class of Service defines the
transmission priority of outbound bundles from three
ION priority queues corresponding to bulk, standard,
and expedited priorities. The expedited priority
queue must be empty before bundles in the standard
or bulk queues are serviced by ION. Therefore,
bundles with expedited priority should only be sent in
critical/emergency situations.

Expedited Priority Ordinal The expedited priority ordinal is only associated with
the expedited priority class of service.
Transmission Mode The transmission mode defines the reliability of

bundle delivery to a destination. The three
transmission modes supported are best effort, assured,
and assured with custody transfer.

Criticality A critical bundle is one that has to reach its
destination as soon as is physically possible. For this
reason, bundles flagged as critical may not include
custody transfer and require an ION configuration
with contact graph routing. In some cases, a critical
bundle may be sent over multiple routes to ensure
delivery to its final destination. Critical bundles are
placed in the expedited priority queue and should
only be used in emergency situations.

Note: The Get directive is not supported in all ISS CFDP implementations. It is
supported by TReK when both the sender and receiver are TReK CFDP implementations
(TReK CFDP application, TReK CFDP console application, or TReK CFDP Library).

In addition to this application, TReK also includes a CFDP console application and a
CFDRP library. If you need CFDP functionality onboard a spacecraft consider the TReK
CFDP console application. If you need to include CFDP functionality in your own
application, consider the TReK CFDP library. The TReK CFDP library can be used to
include CFDP functionality in a ground or flight application.

4 Overview of the User Interface

41 Main Window

The main window contains several areas as shown in Figure 2. Each area is a dock
window that you can float or dock. To float a dock window, use your left mouse button
to click and hold the title area while dragging the window to another area of the screen.
To dock, use the title bar to drag the dock window over the main window and drop.
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r R
[ TReK CFDP - Untitled = | B ||
File View CFDP Options Help
Configuration: . Configure | Operational: . Activate
CFDP Comman ds g X
Action Transmission Source Remote EID  Destination Add Row
Remove Rov
Export List
Import List
<= Show Directory Default Destination: | Nene nA Clear Al Restore Al
Transactions g X
Transac| tionID Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure...
Message Area g X
—
Figure 2 Main Window

The toolbar at the top of the window provides quick access to configure the application
and start and stop the CFDP service.

CEDP Commands

The CFDP Commands area provides a way to add and execute one or more CFDP
commands (primitives). Add a “put” command to send a file to a remote entity. Add a
“get” command to retrieve a file from a remote entity. The “Show Directory” button
provides access to the local file system. Files can be dragged from this view of the local
file system or from a file explorer window. Files can also be added by pushing the Add
Row button and typing in the file transfer information. To delete a file from the list put
your cursor in the row you would like to delete and push the Remove Row button. To
delete all files in the list push the Clear All button. The Export List button provides a
way to save the list of CFDP Commands in a file. The Import List button provides a way
to load a list of CFDP Commands from a file. Each CFDP command entered into the list
must include a directive, transmission information, the absolute path of the source file,
the Remote Entity ID (Remote EID), and the absolute path of the destination file. To
execute all the CFDP commands in the list, push the Execute All button. After you push
the Execute All button, the Restore All button can be used to restore the list of
commands. The Restore All button will only restore the list of CFDP commands
previously sent by pushing the Execute All button. The Default Destination menu can be
used to identify a default destination. This can save typing when dragging and dropping
files into the list. If the Default Destination is set, the destination selected will
automatically be copied into the Destination field when a file is dropped into the list. The
Default Destination menu can be populated using the Configure dialog.
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Note: You can enter the absolute path for a directory in the Source and Destination
fields. All the files in the first level of the directory will be transferred. Subdirectories
will not be transferred. Each file in the directory will result in the execution of an
individual CFDP Command (primitive). Therefore, the transactions area will contain
transaction information for each file transferred.

Note 2: There are two types of configuration files for the CFDP application: the CFDP
Application Configuration File and the CFDP Commands List file. File/Save/Save As
can be used to save an Application Configuration File. The File/Open command provides
a way to open an Application Configuration File. The Export List button provides a way
to save a CFDP Commands List file. The Import List button provides a way to load a
CFDP Commands List file.

Transactions

The Transactions area displays file transfer activity as it is in progress. The Configure
button displays the Configure dialog which provides a way to show and hide columns and
rearrange the order of the columns. To Clear, Pause, Resume, or Cancel one or more
transactions, select the transactions in the list and push the desired button.

Message Area
The Message Area displays important status and error messages. The message area can

be cleared using the View menu.

4.2 Toolbar

The toolbar provides visual information about the state of the application and provides
access to common application functions.

Configuration Status

When the Configuration status is black, this indicates the application has not been
configured. When the Configuration status is green, this indicates the application has
been configured and the CFDP service can be activated.

Use the Configure button to access the Configure dialog to configure the application.

Operational Status

When the Operational status is black, this indicates the CFDP service is inactive. When
the Operational status is green, this indicates the CFDP service is active and file transfer
is supported. The application must be properly configured before the Activate button will
be available. The CFDP service must be active before the Deactivate button will be
available.

Use the Activate button to activate the CFDP service. This will initiate all internal
activities needed to prepare the application to send and receive files. When you activate
the CFDP service, you will see activation status messages in the main window message
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area. If you need to reconfigure the CFDP application, deactivate the CFDP service, and
then push the Configure button to reconfigure.

4.3 Menus

The CFDP application menus are: File, View, CFDP, Options, and Help. Each of these
menus is described in more detail below.

File Menu
The File menu provides the capability to manage configurations and exit the application.

View Menu
The View menu provides the capability to clear the main window message area and show
and hide different areas in the main window.

CEDP Menu

The CFDP menu provides the capability to configure the application, activate and
deactivate the CFDP service, apply Pause, Resume, Cancel, or Clear to all transactions in
progress, and Reset Metrics. Reset Metrics can be used to reset all the metrics to 0 in the
metrics log file that is currently open. The Metrics log file will only be open when
Metrics Logging is on and the CFDP service is active.

Options Menu
The Options menu provides access to the Messages dialog, the Configure Message

Logging dialog, the Configure Statistics Logging dialog, and Reset Statistics. The
Messages dialog displays application messages. The Configure Message Logging dialog
provides the capability to configure message logging. The Configure Statistics Logging
dialog provides the capability to configure statistics logging. Reset Statistics can be used
to reset all the statistics to 0 in the statistics log file that is currently open. The Statistics
log file will only be open when Statistics Logging is on.

Help Menu
The Help menu provides access to on-line help and application version information.

5 Quick Start Guides
This section provides “How Tos” for common functions.

5.1 How to Configure the Application for Native CFDP

The following steps describe the minimum necessary to configure the application. For
additional information and details about the Configure dialog please reference section
6.1.
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1. Push the Configure button to display the Configure dialog.

2. Select the Native CFDP radio button.

3. Enter your Entity ID in the Local Entity ID field.

4. Push the + button to create a row to enter Remote Entities information. For each
remote entity, enter the Remote Entity ID, the Remote IP Address, and Remote Port.
You must enter one or more remote entities.

5. Ensure the CFDP Socket Local IP Address contains a valid local IP address.

6. Push the OK button to save the configuration information and exit the dialog.

If the application is configured correctly, the Configuration status will be green.

5.2 How to Configure the Application for ION CFDP

The following steps describe the minimum necessary to configure the application. For
additional information and details about the Configure dialog please reference section
6.1.

1. Push the Configure button to display the Configure dialog.

2. Select the ION CFDP radio button.

3. Modify the ION CFDP properties as needed.

4. Push the OK button to save the configuration information and exit the dialog.

If the application is configured correctly, the Configuration status will be green.

5.3 How to Configure Application Defaults

This section describes how to configure application defaults using the Configure dialog
Options tab.

1. Push the Configure button to display the Configure dialog.

2. Go to the Options tab.

3. Enter a Default Remote EID. When you drag and drop files into the “CFDP
Commands” list or the CFDP Command field, the default Remote EID entered here
will automatically be used as the Remote EID.

4. Enter one or more Default Destination Paths. These paths will be added to the
Default Destination menu shown on the main window. The Default Destination
menu will also contain a "None" item and a "Same As Source" item. When dragging
and dropping files, the item selected in the Default Destination menu will determine
what is placed in the Destination field. This will work as follows:

e If "None" is selected the Destination field will be blank.
e If "Same As Source" is selected, the Source information will be copied into the
Destination field.
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e |f apath is selected, and you are dragging and dropping a file, the path selected on
the Default Destination menu will be copied into the Destination field and
appended with the Source filename.

e |f apath is selected, and you are dragging and dropping a directory, the path
selected on the Default Destination menu will be copied into the Destination field.

5. Push the OK button to save the configuration information and exit the dialog.

5.4 Drag and Drop Features

Drag and Drop is the fastest way to create a list of CFDP commands to transfer one or
more files and/or directories. Simply Drag and Drop one or more files from the Directory
area in the CFDP main window (“CFDP Commands” area) or from an Explorer window.

You can optimize your Drag and Drop experience by setting application defaults such as
Default Remote EID and Default Destination Paths. To set these defaults see section 5.3.

5.5 How to Save a CFDP Command List

A CFDP Command List can be saved by saving the application configuration using the
File menu’s Save/Save As items or by using the Export List button on the Main Window.
If the application configuration is saved, the entire application configuration, including
the CFDP Command List, will be saved in the configuration file. If the Export List
button on the Main Window is used, only the CFDP Command List will be saved in the
file.

The File menu’s Open menu item can only open a TReK CFDP Application
Configuration file.

The Import List button on the Main Window can only be used to read a CFDP Command
List file.

5.6 How to Start and Stop the CFDP Service
This section describes how to start and stop the CFDP service.

1. Before the CFDP service can be started, you must configure the application. To learn
more about this see section 5.1. The Configure status must be green before you can
start the CFDP service.

2. If you are configured for ION CFDP, you must start the ION software before starting
the CFDP service.

3. To start the CFDP service, push the Activate button on the toolbar. If this is
successful the Operational status will turn green. When the Operational status is
green you can transfer files (send or receive files).

4. To stop the CFDP service, push the Deactivate button.

10
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5. When activating or deactivating important status and/or error messages will be
displayed in the Main Window message area.

5.7 How to Put (Send) a File

This section describes how to put (send) a file. This procedure applies to both Native
CFDP and ION CFDP.

1. The CFDP application must be configured and the CFDP service must be active.

2. Drag and Drop a file into the “CFDP Commands” area.

3. Ensure the Put, Transmission, Source, Remote EID and Destination information is
correct. If the application is configured for Native CFDP, the Transmission should be
classl or class2. If the application is configured for ION CFDP, the Transmission
should be “////”. The “////” indicates the ION CFDP parameter values defined in the
Configure dialog will be used during transmission. The Source should identify the
absolute path of the file to be sent. The Remote EID should identify the target Entity.
The Destination should identify where to store the file at the target location.

4. Push the Execute All button.

Note: If you want to transfer the contents of a directory, you can enter the absolute path
for a directory in the Source and Destination fields. All the files in the first level of the
directory will be transferred. Subdirectories will not be transferred. Be sure to include a
forward slash /> at the end of the directory path.

If the text is red, this indicates there is problem with the information provided. Until this
is corrected it will not be possible to successfully perform the file transfer.

5.8 How to Get (Retrieve) a File

This section describes how to get (retrieve) a file. This procedure applies to both Native
CFDP and ION CFDP.

Special Note: 1SS Change Request (CR) 13351 Ku-Band Forward Access for Payload
Operations only required support for the “Put” directive. Therefore, the Get directive is
not supported in all ISS CFDP implementations. It is supported by TReK when both the
sender and receiver are TReK CFDP implementations (TReK CFDP application, TReK
CFDP console application, or TReK CFDP Library).

1. The CFDP application must be configured and the CFDP service must be active.

2. Enter information into the “CFDP Commands” area for the file you wish to get.
Ensure the Get, Transmission, Source, Remote EID, and Destination information is
correct. If the application is configured for Native CFDP, the Transmission should be
classl or class2. If the application is configured for ION CFDP, the Transmission
should be “////”. The *“////” indicates the ION CFDP parameter values defined in the
Configure dialog will be used during transmission. The Source field should identify
the absolute path of the file to be retrieved from the target entity. The Remote EID

11
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should identify the target Entity. The Destination field should identify the location
(including filename) where you want the file to be stored when retrieved.
3. Push the Execute All button.

Note: If you want to transfer the contents of a directory, you can enter the absolute path
for a directory in the Source and Destination fields. All the files in the first level of the
directory will be transferred. Subdirectories will not be transferred. Be sure to include a
forward slash ‘/° at the end of the directory path.

If the text is red, this indicates there is problem with the information provided. Until this
is corrected it will not be possible to successfully perform the file transfer.

5.9 How to Monitor File Transfers

File Transfers can be monitored using the Transactions area in the main window. No
transactions will appear until a file transfer is in progress. Transactions will appear when
a send or receive is in progress. The details about the file transfer will stay in the
Transactions area until they are cleared out.

5.10 How to Configure the Transactions Area
This section describes how to configure the Transactions area.

1. Inthe Transactions area, push the Configure button to display the Configure
Transactions Columns dialog.

2. To show or hide columns, select the column(s) you would like to show or hide and
push the arrow buttons to move the columns to the Available list or the Columns
Showing list as desired.

3. To order the columns use the Move Up and Move Down buttons to order the list. The
top item will be the left most column.

4. Push the OK button to save the configuration and exit.

The Transactions list can be safely configured while transactions are in progress. The
configuration is not saved as part of the application configuration.

5.11 How to Turn on Message Logging

This section describes how to turn on message logging. Various types of application
messages are generated. As you use the application, messages will be displayed in the
main window message area and the Messages dialog. Messages can also be logged to a
file by turning on Message Logging. Message Logging will only capture messages
generated after Message Logging is turned on. Any messages generated before message
logging was turned on will not appear in the message log file.

1. Go to the Options menu and select ‘Configure Message Logging’.
2. Check the Log Messages checkbox to turn Message Logging On.
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Enter a directory for the Log File in the Log File Path field.

Enter a name for the Log in the Log File Name field.

You can select whether debug messages are written to the Message Log using the Log
Debug Messages checkbox.

6. Push OK to save the configuration and exit the Configure Message Logging dialog.

ok w

5.12 How to Turn on Statistics Logging

This section describes how to turn on statistics logging. Various types of application
statistics are generated. Statistics are generated and captured in memory as you use the
application. Statistics can also be logged to a file by turning on Statistics Logging.
When Statistics Logging is on, the Statistics Log file provides a snapshot of the
application statistics from the time the application started or the last statistics reset.

Go to the Options menu and select ‘Configure Statistics Logging’.

Check the Log Statistics checkbox to turn Statistics Logging On.

Enter a directory for the Log File in the Log File Path field.

Enter a name for the Log in the Log File Name field.

You can select whether packet statistics are written to the Statistics Log using the Log
Packet Statistics checkbox.

Push OK to save the configuration and exit the Configure Statistics Logging dialog.

orwdPE

o

5.13 How to Turn on Metrics Logging

This section describes how to turn on metrics logging. Various types of CFDP metrics are
generated. Metrics are generated and captured in memory when the CFDP service is
active. Metrics can also be logged to a file by turning on Metrics Logging. The Metrics
Log file provides a snapshot of the current CFDP metrics starting from the time the
CFDP service was activated or the last metrics reset.

Go to the CFDP menu and select ‘Configure’.

In the Configure dialog select the Options tab.

Check the Log Metrics checkbox to turn Metrics Logging On.
Enter a directory for the Log File in the Log File Path field.
Enter a name for the Log in the Log File Name field.

Push OK to save the configuration and exit the Configure dialog.

ocoarwhE

5.14 How to Use the CFDP Command Line in Native CFDP Mode

This section describes how to use the CFDP Command Line when configured for Native
CFDP.
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Special Note: ISS Change Request (CR) 13351 Ku-Band Forward Access for Payload
Operations only required support for the “Put” directive. Therefore, the Get directive is
not supported in all ISS CFDP implementations. It is supported by TReK when both the
sender and receiver are TReK CFDP implementations (TReK CFDP application, TReK
CFDP console application, or TReK CFDP Library).

1. Go to the View menu and select File Transfer Command Line.

2. Set the Default Destination menu if you would like the application to automatically
fill in the default destination when you drop a file.

3. Dragand Drop a file or Type a CFDP Command into the CFDP Command field.

The following syntax must be used:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]
You may use put or get for CFDP directive.

You may use classl or class2 for Class of Service.

All paths must be absolute paths.

Example:

put class2 D:\filel.txt 2 C:\myfiles\filel.txt

4. Push the Execute button to execute the CFDP command.

The Clear button can be used to clear the CFDP Command field and the Restore button
can be used to restore the last command executed.

Note: If you want to transfer the contents of a directory, you can enter the absolute path
for a directory in the [source-path] and [destination-path] fields. All the files in the first
level of the directory will be transferred. Subdirectories will not be transferred. Be sure
to include a forward slash °/° at the end of the directory path.

5.15 How to Use the CFDP Command Line in ION CFDP Mode

This section describes how to use the CFDP Command Line when configured for ION
CFDP.

Special Note: 1SS Change Request (CR) 13351 Ku-Band Forward Access for Payload
Operations only required support for the “Put” directive. Therefore, the Get directive is
not supported in all ISS CFDP implementations. It is supported by TReK when both the
sender and receiver are TReK CFDP implementations (TReK CFDP application, TReK
CFDP console application, or TReK CFDP Library).

1. Go to the View menu and select File Transfer Command Line.
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2. Set the Default Destination menu if you would like the application to automatically
fill in the default destination when you drop a file.
3. Drag and Drop a file or Type a CFDP Command into the CFDP Command field.

The following syntax must be used:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]

ION CFDP Example: put //// “D:\filel.txt” 2 “/home/kirk/filel.txt”

The TReK CFDP application currently supports multiple CFDP Directives in the ION
CFDP mode. This includes get and put, multiple filestore directives, and the message
directive. These are defined as follows:

Filestore Directive | Description

append_file append a file at the remote entity to another file at the remote
entity.

create_dir create a directory at the remote entity.

create file create an empty file at the remote entity.

delete file delete a file at the remote entity.

deny dir delete a directory at the remote entity. (like remove_dir, but does
not fail if the directory does not exist)

deny file delete a file at the remote entity. (like delete_file, but does not fail
if the file does not exist)

get copy one file from the remote entity to the local entity.

message send a text string to the remote entity.

put copy one file from the local entity to the remote entity.

remove_dir delete a directory at the remote entity.

rename_file rename a file at the remote entity.

replace_file replace a file at the remote entity with another file at the remote

entity.

Some directives only require a Source. The following table describes what is required for
Source and Destination for each directive. Name of file, filename, and name of directory
refer to an absolute path.

Directive Source (first file) Destination (second file)

append_file | name of file whose contents form | name of file whose contents will form
first part of new file and name of second part of new file
the new file

create_dir name of directory to be created

create_file filename to be created

delete_file filename to be deleted

deny_dir name of directory to be deleted

deny file filename to be deleted

get filename for file retrieved filename of file to retrieve

message message
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put filename of file to send filename for file stored

remove_dir | Name of directory to be deleted

rename_file | old filename new filename

replace_file | filename whose contents are to be | filename whose contents will replace the
replaced contents of the first filename

ION CFDP supports spaces in Source and Destination entries. When entering a Source
or Destination in a CFDP command line, it must be encapsulated in double quotes.

The Transmission entry for ION CFDP is composed of five properties. Once these
properties are configured, a ““////” string is used to indicate that the pre-configured values
should be used. The “////” nomenclature is shorthand notation for the following

combination of values:

Lifespan/Bundle Protocol Class of Service/Expedited Priority Ordinal/Transmission Mode/Criticality

When the values are empty it indicates that pre-configured values should be used for

these properties.

The Transmission properties are described below:

Property

Description

Lifespan

The lifespan is the bundle's "time to live” (TTL) in
seconds. The bundle is destroyed if its TTL has
expired and it has not reached its destination.

Bundle Protocol Class of Service

The Bundle Protocol Class of Service defines the
transmission priority of outbound bundles from three
ION priority queues corresponding to bulk, standard,
and expedited priorities. The expedited priority
queue must be empty before bundles in the standard
or bulk queues are serviced by ION. Therefore,
bundles with expedited priority should only be sent in
critical/emergency situations.

Expedited Priority Ordinal

The expedited priority ordinal is only associated with
the expedited priority class of service.

Transmission Mode

The transmission mode defines the reliability of
bundle delivery to a destination. The three
transmission modes supported are best effort, assured,
and assured with custody transfer.

Criticality

A critical bundle is one that has to reach its
destination as soon as is physically possible. For this
reason, bundles flagged as critical may not include
custody transfer and require an ION configuration
with contact graph routing. In some cases, a critical
bundle may be sent over multiple routes to ensure
delivery to its final destination. Critical bundles are
placed in the expedited priority queue and should
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| only be used in emergency situations.

Example:

put //// “D:Milel.txt” 2 “/home/kirk/filel.txt”

4. Push the Execute button to execute the CFDP command.

The Clear button can be used to clear the CFDP Command field and the Restore button
can be used to restore the last command executed.

Note: If you want to transfer the contents of a directory, you can enter the absolute path
for a directory in the [source-path] and [destination-path] fields. All the files in the first
level of the directory will be transferred. Subdirectories will not be transferred. Be sure
to include a forward slash ‘/’ at the end of the directory path.

6 Details
This section covers various application details.

6.1 Configuration

The Configure dialog provides the capability to configure for Native CFDP or ION
CFDP. When Native CFDP is selected, the Native CFDP tab and Options tab will be
displayed. When ION CFDP is selected, the ION CFDP tab and Options tab will be
displayed. The Native CFDP tab is used to configure parameters required for Native
CFDP. The ION CFDP tab is used to configure parameters required for ION CFDP. The
Options tab is used to configure parameters that are optional and apply to both Native
CFDP and ION CFDP.

6.1.1 Native CFDP Tab
The Native CFDP tab is shown in Figure 3. Each field is described below.
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Configuration: @ Mative CFDP () IOM CFDP

Mative CFDP Options

Local Entity ID: 1
Remote Entities
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CFDP Socket Local IP Address:

CFDP Socket Local Port:

CFDP Socket Queue Size:

Ack Timeout (seconds):

Ack Limit:
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Outgoing File Chunk Size (bytes):
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127.0.0.1

4560

1000

5

10

5

10

300

16000

10000000

1

IDE

Browse...

| o
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Figure 3 Configure Dialog (Native CFDP Tab)

Local Entity ID

This field should contain your Entity ID.

Remote Entities List

The CFDP application provides the capability to communicate with one or more entities
when transferring files. The Remote Entities List identifies the Remote Entity ID, the
Remote IP Address, and the Remote Port for each remote entity.

CFDP Socket Local IP Address

A UDP socket is created to send and receive CFDP packets. This is the local IP address

used for the UDP socket.
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CFDP Socket Local Port
A UDP socket is created to send and receive CFDP packets. This is the local port used
for the UDP socket.

CFDP Socket Queue Size

The UDP socket that is created to receive CFDP packets may store CFDP packets in a
queue prior to the packets being processed by the CFDP library. This queue minimizes
the chances of a CFDP packet being dropped due to packet transmission bursts or a
temporary CPU spike on the receiving platform. In general, a larger queue size is needed
for higher transmission rates. If an unacceptable number of CFDP packet retransmissions
is occurring, increasing the queue size or decreasing the file transfer rate may help
decrease or eliminate the CFDP packet retransmissions.

Ack Timeout

The CFDP library sends positive acknowledgment on reception of the end-of-file packet
and finished packet. This timeout defines the length of time the CFDP library will wait
for the Ack packet to arrive prior to retransmitting the end-of-file or finished packet.

Ack Limit

The Ack Limit is the number of Ack timeouts that may occur prior to cancelling the
CFDP transaction.

Nak Timeout

The CFDP library sends a Nak packet identifying the CFDP packets that were not
received by the CFDP library. This timeout defines the length of time the CFDP library
will wait for the retransmission of the requested CFDP packets.

Nak Limit
The Nak Limit is the number of Nak timeouts that may occur prior to cancelling the

CFDP transaction.

Inactivity Timeout

The Inactivity Timeout is the length of time the CFDP library is required to wait between
CFDP packet receptions prior to cancelling the CFDP transaction.

Qutgoing File Chunk Size

The Outgoing File Chunk Size is the maximum size, in bytes, of the data zone of the
CFDP packets created by the CFDP library.

Aqggreqgate File Transfer Rate
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The Aggregate File Transfer Rate represents the maximum transmission rate, in bits per
second, of the CFDP packets created by the CFDP library.

Transaction Cycle Time Interval

The transaction cycle time interval, in milliseconds, controls the processing rate of CFDP
library transactions. Minimizing the cycle time, increases the transaction speed or
processing rate. The default and minimum value is 1 millisecond. This value should only
be incremented if CPU usage on the host platform is unexpectedly high while idling or
while processing a transaction.

6.1.2 ION CFDP Tab
The Native CFDP tab is shown in Figure 4. Each field is described below.
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[ Configure l ? &J

Configuration: (—) Mative CFDP (@ ION CFDP

IOM CFDP Options |

Lifespan (seconds): 25400

Bundle Protocol Class of Service: [Smndard Priarity - ]

Expedited Priority Ordinal; 0

Transmission Mode: [Assured - ]

Criticality: | Not Critical - |

Transaction Result Message; Timeout (seconds): 300

[ oK, ] [ Cancel

Figure 4 Configure Dialog (ION CFDP Tab)

Lifespan
The lifespan is the bundle’s "time to live" (TTL) in seconds. The bundle is destroyed if its

TTL has expired and it has not reached its destination. The default value is 86400.

Bundle Protocol Class of Service

The BP class of service defines the transmission priority of outbound bundles from three
ION priority queues corresponding to bulk, standard and expedited priorities. The three
BP class of service parameter values are BULK_PRIORITY, STD_PRIORITY and
EXPEDITED_PRIORITY. The expedited priority queue must be empty before bundles
in the standard or bulk queues are serviced by ION. Therefore, bundles with
EXPEDITED_PRIORITY should only be sent in critical/emergency situations. The
default value is STD_PRIORITY.
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Expedited Priority Ordinal

The expedited priority ordinal is only associated with the EXPEDITED_PRIORITY class
of service. Ordinal values range from O (lowest priority) to 254 (highest priority). The
default value is 0.

Transmission Mode

The transmission mode defines the reliability of bundle delivery to a destination. The
three transmission mode parameter values are BEST_EFFORT, ASSURED and
ASSURED_WITH_CUSTODY_TRANSFER. BEST_EFFORT relies upon the
underlying convergence-layer protocol (e.g., Transmission Control Protocol or TCP) to
retransmit missing bundles. ASSURED is a step up in reliability and includes BP support
in detecting a lost TCP connection and re-forwarding of bundles assumed aborted by the
convergence-layer protocol failure. ASSURED WITH_CUSTODY_TRANSFER
requires the reception, by the sending node, of a custody acceptance or refusal signal
(packaged in a bundle) from the receiving node. The default value is

ASSURED WITH _CUSTODY_TRANSFER.

Criticality

A critical bundle is one that has to reach its destination as soon as is physically possible.
For this reason, bundles flagged as critical may not include custody transfer and require
an ION configuration with contact graph routing. In some cases, a critical bundle may be
sent over multiple routes to ensure delivery to its final destination. Critical bundles are
placed in the expedited priority queue and should only be used in emergency situations.
The two criticality parameters are NOT_CRITICAL and CRITICAL. The default value is
NOT_CRITICAL.

Transaction Result Message

The support transaction result boolean enables the generation and transmission of a
CFDP transaction result message to the source node. If the source node receives the
transaction result message within a designated time window, it will update its transaction
status with the transaction result (e.g., success or fail). If the support transaction result
boolean is set to "true” and the result message is not received within a designated time
window, the source node's transaction status is set to "unknown". If this boolean is set to
"false” and the source node did not experience any problems while transmitting the
CFDP transaction request, the final transaction status is set to "finished". This capability
is only supported by the TReK CFDP library. Therefore, the TReK CFDP library
software must be running on both the source and destination nodes. The default value is
true.

Transaction Result Message Timeout

The transaction result message timeout is the length of time, in seconds, the TReK CFDP
library will wait for a transaction result message prior to setting the final status of the
transaction to "unknown". The default value is 300.
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6.1.3 Options Tab
The Options tab is shown in Figure 5. The Options tab items are applicable regardless of
whether Native CFDP or ION CFDP is selected. Each field is described below.

L2 [ |

( E Configure

Configuration: @ Mative CFDP (7) ION CFDP

Mative CFDP Options

Default Remote EID:

Default Destination Paths

Destination Path

L]

[ Log Metrics
Log File Path: | C:\Usersimps

Log File Mame: |toolkit_cfdp_metrics.caw

[ oK ] [ Cancel

Figure 5 Configure Dialog (Options Tab)

Default Remote EID
The Default Remote EID is used during Drag and Drop. If this field contains a value,

this value will be entered as the Remote EID when you drag and drop a file into the
“CFDP Commands” list or the “CFDP Command” field.

Default Destination Paths
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The Default Destination is used during Drag and Drop. All destinations listed in the
Default Destination Paths list will appear in the “Default Destination” menu on the CFDP
main window. When you drag and drop a file into the “CFDP Commands” list or the
“CFDP Command” field, the destination selected from the Default Destination menu will
automatically be entered into the Destination field.

Log Metrics
The CFDP application provides the capability to write metrics to a file. If you check Log

Metrics, metrics will be written to the log file specified. Metrics Logging will start when
CFDRP is activated and stop if you uncheck the box or CFDP is deactivated. See Section
6.4 for details on what metrics are logged.

Log File Path
The Log File Path should contain the absolute path to the directory where the log file

should be written.

Log File Name
The Log File Name field should contain the name to use for the log file.

6.2 Transactions
This section describes the columns in the main window Transactions area.

Transaction ID
The transaction ID. A unique ID used to identify a transaction.

Remote EID
The Entity ID of the other party involved in the transfer.

Status

The status of the transaction: Sending, Receiving, Finished, Success, Fail, Unknown, etc.
The Status field updates as the transaction progresses. The final status of a transaction
using ION CFDP is “Finished” if the TReK CFDP application is not configured to
receive a final transaction message from the remote site. If the TReK CFDP application
is configured to receive a final transaction message, and the message does not arrive in
the user defined timeout period, the final status is “Unknown”.

% Complete
The % complete of the file transfer. The % Complete field updates as the transaction

progresses. This field is not relevant for ION CFDP filestore directives and message
directives.

Bytes Transferred
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The number of bytes transferred. The Bytes Transferred field updates as the transaction
progresses. This field is not relevant for ION CFDP filestore directives and message
directives.

Source
The source identified in the CFDP command.

Destination
The destination identified in the CFDP command. This field is not relevant for ION
CFDP message directives and some filestore directives.

Configuration
The configuration field indicates the direction of the file transfer: “Sending” or

“Receiving”.

File Size
The File Size field displays the size of the file being transferred in bytes. This field is not
relevant for ION CFDP filestore directives and message directives.

6.2.1 Configure Transactions Columns Dialog

The Configure Transactions Columns dialog provides the capability to configure the
columns shown in the Transactions area. The Columns Showing list identifies the
columns that will be displayed. The arrow buttons provide the capability to move items
between the Available Columns list and the Columns Showing list. To hide a column,
move it from the Columns Showing list to the Available Columns list. The Move Up and
Move Down buttons provide the capability to specify the order of the columns showing.
The item listed at the top of the list will appear in the left most location in the
Transactions area. The configuration of the Transactions area (columns showing/column
order) is not saved.

E Configure Transactions Columns lilﬂ_hj

Available Columns Columns Showing
Transaction ID
Remote EID
Status

% Complete
Bytes Transferred
Source

m

Destination
Configuration

K | | Cancel

Figure 6 Configure Transactions Columns Dialog
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6.3 Statistics

This section describes the statistics that can be logged by the application to a user
specified file. Statistics include device statistics and packet statistics. The snapshot of
device and packet statistics is updated once a second with current statistics information at
both the device and packet level. Device statistics provides information on all packets
that are being received or sent by the device. Packet statistics provides information on
the individual packet groups that are being received or sent by the device. The TReK
CFDRP library that performs this work for the application does not divide packets into
groups so packet statistics mirror device statistics.

Device Statistics

Device Key
A character string that uniquely identifies each device.

IP_ Address
The IP address of the device if it is a socket.

Port (C/L/S)

The port number of the device if it is a socket. If the socket is a client socket then the
port number will be followed by two °/°. If the client socket is connected to a listener
socket, the listener’s port number is also listed. If the socket is a server socket then the
client port number that is connected to the server is listed first, followed by two ‘/* and
the server’s listener port number. If the socket is a listener socket the listener’s port
number is listed between two /°.

Protocol
The IP transportation protocol, either TCP or UDP, if the device is a socket.

Segments Revd
The number of segments received by the device if the device is a TCP socket.

Pkts Revd
The total number of packets received by the device.

Pkts Sent
The total number of packets sent by the device.

Pkt Rcv Rate
The number of packets received by the device in the last second.

Max Pkt Rcv Rate
The maximum packet receive rate experienced by the device.

Kbit Rcv Rate
The number of kilobits received by the device in the last second.
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Max Kbit Rcv Rate
The maximum kilobit receive rate experienced by the device.

Pkt Send Rate
The number of packets sent by the device in the last second.

Max Pkt Send Rate
The maximum packet send rate experienced by the device.

Kbit Send Rate
The number of kilobits sent by the device in the last second.

Max Kbit Send Rate
The maximum kilobit send rate experienced by the device.

Pkts Dropped
The total number of packets that were dropped because they could not be temporarily

stored in a queue or buffer. The most likely cause of dropped packets is packets arriving
at very high packet rates and/or a queue size that is too small.

Packet Statistics

Packet Key
A character string that uniquely identifies each packet type.

Pkts Revd
The total number of packets that are received and identified as this packet type.

Pkts Sent
The total number of packets that are sent and identified as this packet type.

Pkt Rcv Rate
The number of packets received and identified as this packet type in the last second.

Max Pkt Rcv Rate
The maximum packet receive rate experienced by this packet type.

Kbit Rcv Rate
The number of kilobits received and identified as this packet type in the last second.

Max Kbit Rcv Rate
The maximum kilobit receive rate experienced by this packet type.

Pkt Send Rate
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The number of packets of this packet type sent in the last second.

Max Pkt Send Rate
The maximum packet send rate experienced by this packet type.

Kbit Send Rate
The number of kilobits of this packet type sent in the last second.

Max Kbit Send Rate
The maximum kilobit send rate experienced by this packet type.

Pkts Dropped
The total number of packets, of this type, that were dropped because they could not be

processed by another device. The most likely cause of dropped packets is packets
arriving at very high packet rates.

Pkt Seq Errors
The total number of packet sequence errors identified for this packet type. For example,

the primary header of the CCSDS packet contains a 14-bit number that is used as a
sequence count. For each packet that arrives, the sequence count is compared to

the sequence count of the previous packet. If the count is not the next in the sequence, the
packet sequence error value is incremented.

Max Pkt Seq Error
The maximum packet sequence error experienced by this packet type.

6.4 Metrics

This section describes the CFDP metrics that can be logged by the application. The
snapshot of CFDP metrics is updated once a second with the completion status of each
CFDP transaction. The CFDP metrics are divided into sending and receiving categories
and grouped by file size ranging from less than a one megabyte to over a gigabyte. The
metrics include calculations on the number and percent of files sent or received, the
minimum, maximum, and average file transfer time, and the number and percent of files
that required packet retransmission.

The following Metrics are provided for Sending and Receiving.

File Size (MB)
The minimum and maximum file size, in megabytes, for the group.

Success Count
The number of successful file transfers for the group.

Success %
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The percentage of successful file transfers for the group.

Cancel Count
The number of canceled file transfers for the group.

Abandon Count
The number of abandoned file transfers for the group.

Fail Count
The number of failed file transfers for the group.

Unknown Count
The number of unknown file transfers for the group.

Min Trans Time (sec)
The minimum successful file transfer time in seconds.

Max Trans Time (sec)
The maximum successful file transfer time in seconds.

Avqg Trans Time (sec)
The average successful file transfer time in seconds.

Success W/NAK Cnt
The number of successful file transfers that required one or more NAK packets.

Success W/ NAK %
The percentage of successful file transfers that required one or more NAK packets.

Min NAK Cnt/Trans
The minimum number of NAK packets that had to be transferred for a successful file
transfer requiring NAK packets.

Max NAK Cnt/Trans
The maximum number of NAK packets that had to be transferred for a successful file
transfer requiring NAK packets.

Avg NAK Cnt/Trans
The average number of NAK packets that had to be transferred for a successful file
transfer requiring NAK packets.

6.5 Configure Message Logging

This section describes how to configure message logging. The Configure Message
Logging dialog is shown in Figure 7. This dialog can be displayed using the Options
menu Configure Message Logging menu item.
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E Configure Message Logging @Iéj

Log Messages

OK ] | Cancel

Figure 7 Configure Message Logging Dialog

Each field is described below.

Log Messages
The CFDP application provides the capability to write application messages to a file. If

you check Log Messages, application messages will be written to the log file specified.
Logging will start once it is turned on, so any messages generated before logging was
turned on will not appear in the file.

Log File Path
The Log File Path should contain the absolute path to the directory where the log file

should be written.

Log File Name
The Log File Name field should contain the name to use for the log file.

Log Debug Messages
The Log Debug Messages checkbox specifies whether debug messages should be written
to the log. For example, if Debug is checked, Debug messages will be written to the log.

6.6 Configure Statistics Logging

This section describes how to configure statistics logging. The Configure Statistics
Logging dialog is shown in Figure 8. This dialog can be displayed using the Options
menu Configure Statistics Logging menu item. Statistics are generated and captured in
memory as you use the application. Statistics can also be logged to a file by turning on
Statistics Logging. When Statistics Logging is on, the Statistics Log file provides a
snapshot of the application statistics from the time the application started or the last
statistics reset. See Section 6.3 for details about the statistics that are logged.
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Log Statistics

Log File Path: | C:\Users\mps

Log File Mame: | toolkit_cfdp_statistics.cav

Log: Packet Statistics

QK ] | Cancel

L

Figure 8 Configure Statistics Logging Dialog

Each field is described below.

Log Statistics
The CFDP application provides the capability to write application statistics to a file. If

you check Log Statistics, application statistics will be written to the log file specified.

Log File Path
The Log File Path should contain the absolute path to the directory where the log file

should be written.

Log File Name
The Log File Name field should contain the name to use for the log file.

Log Packet Statistics
The Log Packet Statistics checkbox specifies whether packet statistics should be written
to the log. For example, if Packet is checked, packet statistics will be written to the log.

6.7 Application Messages

Various types of application messages are generated including information, progress,
warning, error, and debug messages. Information, warning, and error messages will be
displayed in the main window message area. All application messages are sent to the
Messages dialog shown in Figure 9. The Messages dialog can be configured to display
specific types of messages. By default, the Messages dialog will display information,
progress, warning, and error messages. Columns in the Messages dialog can be sorted by
clicking on the column header. The Messages dialog is available from the Options menu.
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Time CateTg ory Message

GMT 2014-04-11 11:26:58:846 Progress cfdp_engine: 'ack_timecout’ set to 'S,

GMT 2014-04-11 11:26:58:848 Progress cfdp_engine: "ack_limit' set to ‘25"

GMT 2014-04-11 11:26:58:849 Progress cfdp_engine: 'nak_timecut' set to 'S,

GMT 2014-04-11 11:26:58:851 Progress cfdp_engine: 'nak_limit' set to 25",

GMT 2014-04-11 11:26:58:852 Progress cfdp_engine: "inactivity_timecut' set to ‘56400,

GMT 2014-04-11 11:26:58:854 Progress cfdp_engine: ‘'outgoing_file_chunk_size' set to 1400, -

[Cunﬁgure... ] [ Clear... ] [ Export...

Figure 9 Messages Dialog

Configure
The Configure button provides access to the Configure Messages dialog shown in Figure

10. This dialog is used to filter the types of messages (category) displayed in the
Messages dialog.

Configure Messages ‘ @g

Display: Info Progress Warning Error [ | Debug

: [ Ok J[ Cancel ] |

Figure 10 Configure Messages Dialog

Clear

The Clear button provides access to the Clear Messages dialog shown in Figure 11. This
dialog provides two ways to clear messages in the Messages dialog. You can clear all the
messages or clear selected messages. Once you clear messages, the messages are
permanently deleted.

] Clear Messages &Ig

@ Clear All Messages

() Clear Selected Messages

'_ [ Ok ][ Cancel ]

Figure 11 Clear Messages Dialog
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Export
The Export button provides the capability to save all the application messages to a file.

When you push the Export button you will be prompted for a directory and filename.
Export will save all messages, not just the messages currently displayed in the Messages
dialog (i.e. the ‘Configure’ filter is not applied). The name you provide for the file will
be modified with a time tag prefixed to the filename. The time tag indicates the time the
file was closed. For example:

Filename Input: messages.txt
Filename Output: GMT_2014-04-10_16~57~27~182_messages.txt.

6.8 Application Configuration File
The CFDP application saves the following information when you save a configuration:

Configuration information in the Configure Dialog.

CFDP Commands list displayed in the Main Window CFDP Commands area.
CFDP Command displayed in the Main Window File Transfer Command Line.
Default Destination menu selection in the CFDP Commands area.

Default Destination menu selection in the File Transfer Command Line area.
Log Messages Configuration

Log Statistics Configuration

Configure Messages Checkbox Selections

The configuration of the Transactions area (columns showing/column order) is not saved.

6.9 Application Settings

The CFDP application saves some settings as application settings each time you exit the
application. The next time you run the application, the application will initialize with the
previous application settings. The following application settings are saved:

e Application Window Size
e Application Window Position

7 FAQ and Troubleshooting

This section addresses Frequently Asked Questions and provides tips for troubleshooting
common gotchas.

7.1 Is There an Easy Way to Transfer the Contents of a Directory?

Yes. To transfer the contents of a directory, enter the absolute path to the directory. The
CFDP application will transfer all the files in the first level of the directory.
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Subdirectories will not be transferred. Be sure to include a forward slash ¢/’ at the end of
the directory path when entering the absolute path into the Source and Destination fields.

7.2 Whatis classl and class2?

Classl and class2 are transmission properties used with Native CFDP. Note: Special
thanks to NASA/GSFC for the following user friendly definitions:

“CFDP provides three Service Classes. Service Class 1 simply sends each file; there are
no replies from the receiver, nor is there any guarantee of reliable delivery. Service
Class 2 ensures reliable file delivery; any required retransmissions are requested and
performed by CFDP. Service Class 3 provides Proxy Operations (e.g. Entity ‘A’ tells
Entity ‘B’ to make a request of Entity ‘C”).”

The TReK CFDP application supports Class 1 and Class 2 when configured for Native
CFDP. When typing in one of these choices please use classl and class2.

7.3 Whatis “////”?

“////”” is a value used to designate the default set of transmission properties defined in the
Configure dialog for ION CFDP. “/” can also be used. When configured for ION
CFDP, transmission properties are specified using the Configure dialog and will apply to
all CFDP transactions. For more information about transmission properties please
reference section 6.1.2,

7.4 Source and Destination Constraints
Source and Destinations must be identified using an absolute path. The absolute path

name consists of the full path and the file name. The absolute path must meet the
following criteria:

The absolute path must not contain spaces when configured for Native CFDP.
The absolute path can contain spaces when configured for ION CFDP.

The absolute path cannot exceed 256 characters (null terminated).

The size of the file to be transferred must be greater than 0 Bytes.

The size of the file to be transferred cannot exceed 2.1 Giga Bytes.

7.5 1 Dropped My File into the List and it Turned Red

Red indicates the file or directory contains an illegal character. File and directory names
must meet the File and Directory Name Constraints described in section 7.4.
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7.6 My File Starts to Transfer and Then Stops

Chances are the remote entity is unavailable or is not configured as you expected. Check
both the Local and Remote entity configurations and ensure the EIDs are correct, the IP
address and port information is correct, and both entities are up and running.

7.7 Transfer Results When Item Exists At Destination
Transfer results when an item exists at a destination differ based on configuration.

When configured for Native CFDP

If you attempt to “put” an item to a destination on a Windows computer, and the item
already exists at the destination, you will see a “cancelled (Filestore rejection)” error
message and the item will not be overwritten. If you attempt to “put” an item to a
destination on a Linux computer, and the item already exists at the destination, the item
will be overwritten.

When configured for ION CFDP

If you attempt to “put” an item to a destination on a Windows computer, and the item
already exists at the destination, the “put” transaction status will show “Fail”. If you
attempt to “put” an item to a destination on a Linux computer, and the item already exists
at the destination, the “put” transaction status will show “Fail”.

7.8 Important Things To Know When Using The Get Primitive

The TReK CFDP software provides the capability to "get" or retrieve one or more files
from a remote destination. It is important to note that the CFDP Blue Book describes
implementation of a "get" as a proxy "put”. TReK does not implement a CFDP Blue
Book defined proxy "put” function. Therefore, the "get" request will only succeed if both
sides of the file delivery transaction are using TReK software. The TReK get function
initiates the file transfer process by delivering an equivalent "put"” primitive character
string to the remote platform's CFDP software. There are some error scenarios in which
the initiator of the “get” receives no feedback. Some examples are:

e The get request never reaches the remote platform.
e The requested file(s) do not exist on the remote platform in the location specified in
the get request.

If the “get” request reaches the remote platform, the remote platform log file may contain
status information regarding the request.

7.9 How Does Pause Transactions Work?

When configured for Native CFDP

CFDP pauses transactions by pausing both data transmission and timeout clocks
associated with the local platform’s file transfer transactions. The remote platform is not
notified of the pause of file transfer transactions on the local platform and may exceed its
timeout limits if the local platform does not resume its file transfer transactions for an
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extended period of time. If the local file transfer pause is for an extended period of time,
the remote platforms should receive a separate pause transaction command to avoid
exceeding its timeout limits. Both platforms may resume file transfer transactions when
they receive separate resume file transfer transaction commands.

When configured for ION CFDP

The ION CFDP application completes its file transfer responsibilities when it hands off to
ION’s BP application. The handoff may be relatively quick depending on the size of file.
The pause transaction request will not pause/suspend a files transfer after the ION CFDP
application hands off a transaction to ION’s BP application. The pause transaction
request does not affect ION CFDP file reception. The lifespan of the packet bundles
must also be considered when pausing for an extended period of time.
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